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Preface

This User Guide is been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

e Persons in charge of introducing automation devices.
e Persons who design automation systems.

e Persons who install or connect automation devices.

e Persons who manage working automation installation.
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4@ Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,
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cabinet, or electric control room should be limited to authorized personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

e Incase of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

e Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

AW Avertissements:

e Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contrdleur.

e Une utilisation incorrecte de ce produit peut endommager gravement le contréleur.

e Reportez-vous au Guide de I'utilisateur du contréleur pour les considérations de
cablage.

e Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui I'accompagne.

e La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au controleur.

e La maintenance doit étre effectuée avec I'’équipement hors service et déconnectée de
toutes les sources d'alimentation.

e Faites attention lors de I'entretien des composants sensibles a |'électricité statique.
Les recommandations du fabricant pour ces composants doivent étre suivies.

e Les automates de la famille M-Duino sont des controleurs de type ouvert. Il est
nécessaire d'installer I'automate M-Duino dans un boitier, une armoire ou une salle de
controble électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de I'installation des automates de la
famille M-Duino.

e Encas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

e Ne débranchez pas I'équipement en présence d'une atmospheére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

¢ Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

¢ Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS'’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR
REPAIR.
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INDUSTRIAL SHIELDS

1 General Description GPRS / GSM CONTROLLER 54ARA 1/Os
PLUS

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and D the shield from above. Having a B & C in the middle of them. It
has 4 zones (A, B, C & D):

.- . od - — 4 iy -
ER- | E}
STy ) o
W oW w z2:2 2
Ywwy z2zz2
§35858 ~ [cNeNeoNe]
N NNN DO >
<m0o0 Tl pZONE Q0 @ <

S0 1 CZONE

Wiy B ZONE

S ' A ZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named I1.X, being X any number suitable in the
Shield. Digital Outputs are named as Q1.X and Analog Outputs as A1.X.

e The inputs in the zone D are named 12.X, being X any number suitable in the
Shield. Outputs are named as Q2.X and relays as R2.X

10
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1.2 Zone Distribution
ZONE A ~ ZONEB - ZONEC - ZONED
\
Communication \ }
»  Analog Relay *  Analog
= Digital =  Digital

The distribution of the different features that provide the M-Duino 19R I/Os PLUS is the
following one:

Shields B Zone C Zone D Zone
6 Inputs 6 Inputs
(6 Digital Inputs, (6 Digital Inputs, (11 é|l ilpa?lljrzs uts
4 of which can work as | 4 of which can work as | 4 ¢ whic% can v?/ork' as
Digital/Analog Analog Input) Analog Input) Analog Input)
and Relay
Shield 11 Outputs 11 Outputs 6 Outputs
(8 Relay Output, (8 Relay Output, (6 Digital Output,
3 Digital/Analog 3 Digital/Analog 2 OfAWh'fh cgntwotrk as
Output) Output) nalog Output)
1.3 A Zone Features
Shield A Zone
(1x) Ethernet
(1x) UsSB
(1x) 12C
(3x) TTL
Communication | (1x) RS-232

Shield

(1x) HALF/FULL Duplex RS-485

(1x) SPI external Port
(1x) RTC

(1x) uSD Socket

(1x) GPRS/GSM

11
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1.4 Mechanical dimension
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1.5 General Features

CONECTABLE PLC ARDUINO 24 VCC M-DUINO

MODEL TYPE

GRPS/GSM Controller General
Specifications

Information

12 to 24 vdc

Fuse Protection (2.5 A) Polarity

Input Voltage rotection
I max. 15A
Size 101x119.5x119.3
Clock Speed 16 MHz

Flash Memory

256 KB of which 8 KB used by bootloader

SRAM

8 KB

EEPROM

4 KB

Communications

12C — Ethernet Port — USB — GPRS — RS485 — RS232 — SPI
— (2x) RX, TX (Arduino pins)

MAX232 — MAX485 —W5500 —
Sim800L

USB Consideration!

Only meant for uploading or debbuging, NOT ALWAYS
connected as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10 bits
(0-10 Vcce)

Oto10V
Input Impedance: 39K
Separated PCB ground

Digital Isolated Input
(24 Vcc)

7 to 24 Vdc
I min: 2 to 12 mA
Galvanic Isolation

*Interrupt Isolated Input Hs

(24 Vcc)

7 to 24 Vdc
I min: 2 to 12 mA
Galvanic Isolation

12
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Analog Output 8 bits
(0 - 10 Vce)

0to 10 Vdc
I max: 20 mA
Sperated PCB Ground

Digital Isolated Output
(24 Vcc)

5to 24 Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

| max 24 Vdc: 410 mA

Digital Isolated Output
(Relay)

24 VDC / 220 VAC
I max: 5 A
Galvanic Isoltation
Diode Protected for Relay

PWM Isolated Output 8 bits
(24 Vce)

5to 24 Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Expandability

12C — 127 elements — Serial Port RS232 / RS485 / GPRS

*By using this type of signal can no longer use Digital signal (24 Vdc)

13
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2 Technical Specifications:

2.1  General Specifications:

Item

M-Duino PLC Arduino Ethernet 58 I/Os Analog/Digital PLUS

Power supply

voltage DC power supply

12to24Vdc ===

Operating

voltage range DC power supply

11.4t0 25.4Vdc ===

Power
consumption DC power supply | 30VAC max.
Power supply 24vdc ===
External voltage
power supply
Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s?in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0°to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 608g max.

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programming language. “similar to the C”. http://arduino.cc/en/Tutorial/HomePage

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB

Clock Speed 16MHz

Clock Speed 16MHz

14
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Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Arduino
Ethernet 58 I/Os Analog/Digital PLUS:

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / : . .
— Graphical symbols 5031 / Direct Indicates that the equipment IS
- = . f suitable for direct current only;
or use on Current to identify relevant terminals
equipment y
IEC 60417 / Indicates that the equipment is
Graphical symbols , suitable for alternating current
- for use on 5032 (/:Alternatmg only; to identify relevant
. urrent :
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To _|dent|fy the _control by
for use on which a pulse is started.
. General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
. Ground . - .
equipment 5019 is explicily required.
IEC 60417 / : . .
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115/ Signal lamp : )
. lamp(s) is (are) switched on or
equipment

off.

C€

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking applicable European Union
93/42/EEC regulations
ISO 7000/ , .
Graphical symbols Indlcates_a p(.)tentlallly _
f 0434B/ hazardous situation which, if
or use on . . .
) Warning symbol not avoided, could result in
equipment ; e
death or serious injury
ISO 7000/
Graphical symbols 5036 / Dangerous To indicate hazards arising
for use on
. Voltage from dangerous voltages
equipment

15
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3 Precautions

Read this manual before attempting to use the GPRS/GSM 54ARA 1/Os PLUS PLC and follow its
descriptions for reference during operation.

3.1  Arduino Board

The GPRS/GSM Controller includes an Arduino Mega Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate M-Duino according to the performance specifications described in this
manual.

Before using the GPRS/GSM Controller under different conditions from what has been
specified in this manual or integrating GPRS/GSM Controller to nuclear control systems,
railroad systems, aviation systems, vehicles, combustion systems, medical equipment,
amusement machines, safety equipment and other systems, machines, and equipment that
may have a serious influence on lives and property if used improperly, consult your
INDUSTRIAL SHIELDS representative. Ensure that the rating and performance characteristics of
GPRS/GSM Controller are sufficient for the systems, machines, and equipment, and be sure to
provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the GPRS/GSM 54ARA 1/Os PLUS
Controller.

16
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4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Edar lanjuage Bty Enpie Sy Teatart of Ardune
Fatr fort mow
Lrier facw it A aunorvany I (oqures ket of & daw)
oW wrboms gt Axreg csrpbaten []upeac
Corgihe warig Mo
Cragday b rasréses
Erativ Cinde Puidey
Vel code ot ke
L Qamriad 0I0Y
Tt o Lpcten 00 St iy
L Lt 9 wich) Mhes t0 i eemredon on Save (e
| Sawe ater) s fpng o Uphecing

ASSewd Bearcts Mariage LPLE: % [ upen LB bt aeis cortrea e ot e di fuct age_rdnt it e | (1500

2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

17
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4. Go to: Tools -> Board: ... -> Boards Manager

© et rnarite ) Ao 1B

Tide Lt Sormh Tools Hels
Kagn foamad
Awee Sueny
Fix Emnog & Pk oot
Sy Mors b
Lol Moo

WENO Frrm e Ui

Bowit M O bty

Lt thoanet bebs

Fogermm At e 19
B B wiey

W Sty M Do .

RPN

Dosrh Merinpe .

Archaews Yum

A v s

Archaon Dussilanove o Decmia
A Norw

Ak oy Gernens Mege or Maga 2568
Archans Maga ADY
Asthas L senede

w Lessaade ETH
Ak Tmrnmns Mxos
Arthaws Lytona
Arthaws My
Adaw | Derme
A o

Ak W1

L) toaeo S0
Lot fechaco
Aschaens fro o Pys Nvw
Aachaon KGO ok
Asvhang Puokct Coticl
Arthars Ptk Moty
Archan Gesers 4

Adwvan C

#t Mot
Ardune Yom M
Authwws badeig W1

Linkso Onw

Asthans Limz VAT

Ardbax Lty

M Capne harcly

5. Search for “industrialshields” on the browser.

& Boards Manager

y Tope [all | | industrialshields
industrialshields

Boards induded in this padkage:
ARDBCH Farraly, M-Duinc family.

2oling halg

Maora infa

1.18 = In=1a)

Chmae
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6. Click install (selecting the latest version).
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Following these steps you will be able to see now the Industrial Shields Boards:

@ dwteh sugide | Arduine 189

File Eda Sketzh Tosh Help

Aute Faenast CirdaT
Archive Sketch
P Encoding & Reload

1 Manasge Libawies . Chrte Shufte|
Senst Monitos CtrkeShafe- M
Serind Plotter Cirt=Shafte |

WIRTOT / WIKNINA Fuimware Updater
Boedt. "1-Ouinn terniy”

Model "M Dumo 156"

Got Bewd o

Programmer: “Aeduino as 159"

flum Bocticader

Eoardy Manager..

A

Ardane Ho
Ardanc BT
LiyPad Arduno USS
LiyPad Mrduino
Ardano Pro or Pro Mini
Arduine NG o clder
Ardune Robot Contrel
Ardano Robot Motor
Ardanc Gemma
Adatrut Crcunt Playground
Ardang Yun Mini
Arduing lndustyial 101
Linne Oee
Arduinc Uno W

draal Bhiedchs ES
Wi module
Ardhox dpmiy
Ardbex GPRS farly
Arabox WiFUBY tamily
M-Duino temiy
M.Ouing GRS ferrly
M-Duino WIFVBT tamily

Once it is selected the Ardbox Family or M-Duino family an extra option will appear on Tools:

There, it can be selected the exact model for every family. In this case M-Duino 54ARA +

19
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Also there are some examples of programming in File -> Examples -> M-Duino Family.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields/

20
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5 How to connect PLC Arduino to PC

- Connect USB port from PLC to PC.

NOTE:
M-Duino Family uses USB-B cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino Family

- Select the correct M-Duino Board:
M-Duino 54ARA +

- Select correct port.

&9 sketch_auglda | Arduino 1.8.9
File Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch
sketch_augl4{ Fix Encoding & Reload
vold setup (] Manage Libraries... Ctrl+Shift+
/4 PUT YOl serial Monitor Ctrl+ Shift+ M
Serial Plotter Ctrl+Shift+L

}
WiFi101 / WiFiNINA Firmware Updater

void loop ()
/{ put yoi Board: "M-Duine WiFi/BT family" »
Medel: "M-Duine 19R+ WiFi/BT" >
! Port ! Serial ports
Get Board Info COMT2 (Arduino/Genuino Mega or Mega 2560)
Programmer: "Arduino as ISP" >

Burn Bootloader
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6 How to connect PLC to power supply

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[_P':".'".'ER Sup PLTI
GBoo |

|—+ 24voe |

| S pe—t e |

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm

DIN Rail: m\"
-12Vdc / 24vdc .

2.5A

30W

Industrial Shields power supplies provide parallel
operation, overvoltage protection, and overcurrent

T --F

protection. There is a LED inductor for power status,

P

the power supply is certified according to UL.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-
1.

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of
the equipment must be separated from the dangerous voltage cables.
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7 M-duino Family Pinout

7.1 A Zone connection

Base
(common unit)
A Zone
5 £
- [a
28| ¢ g
> C = 6
o< 3 c
T O [ =
=0 < [
SCL 21 12C/SS
SDA 20 12C/SS
RX0 1 RX0/SS
TXO0 0 TXO0/SS
RX1* 19 RX1/SS
TX1* 18 TX1/SS
TX 16 RX2(serial 2)
RX 17 TX2(serial 2)
Z- - RS485
Y+ - RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51 8l 51 SPI
52 SCK 52 SPI
Reset | Reset SPI
Vin5 Vin5 5V
NC NC Not Connected
GND - Gnd
GND - Gnd
24vdc Power Supply

—

Rev 1: 02/03/2020

Configuration Switch* (see section 8 for
configuring the communications.
Enabling communications disables some
1/0s)

Rx1/Tx1 * Pins used for the GPRS module

Communication Pins

Power supply connectors
(24vdc — GND)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

Base
(common unit)
A Zone
5 £
] o
28| ¢ s
S C 5 “5
o c 5 c
[ e} = =1
=0 < [y
AREF AREF  |Arduino PIN
IOREF2 | IOREF2 [Arduino PIN
IOREF1 | IOREF1 [Arduino PIN
7vdc 7Vdc -
GND GND GND
3.3vdc | 3.3vdc [|Arduino PIN
GND GND GND
5vdc 5Vdc -
GND GND GND

DS3(SD)
FO rgass HD
. -
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P W
1 S VI
':‘ 13 "i‘
& : 2
nesxt HE Foog ew E ( ¥
1 FIC Battwry x/ /,_ Socket
Ethernet Arduino Power
Connector Reset button
USB programmer Autoreset

connector

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.
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7.2 B Zone (Analog Shield)

AT 14} ]
10,697 Vo

AT |-
10 AANTD. .]

)10 4—g—
na
)10 Sty
0.3 4
02—ty
02 <ol
L
0l ol

() 1I09—
oo ’“1

B Zone
o & £
2= o
58 g 5
Q= 3 B
= Q B c
o < I
10.12 59 Analog/ Digital In
10.11 58 Analog/ Digital In
10.10 57 Analog/ Digital In
10.9 56 Analog/ Digital In
10.8 55 Analog/ Digital In
10.7 54 Analog/ Digital In
(-)I0.6/INT1 - GND 10.6
10.6/INT1" 3 Interrupt 1 In
NC - Not Connected
NC NC Not Connected
(-)10.4 - GND 10.4
10.4 26 Digital Input
(-)10.3 - GND 10.3
10.3 25 Digital Input
(-)10.2 - GND 10.2
10.2 24 Digital Input
(-)10.1 - GND 10.1
10.1 23 Digital Input
(-)10.0 - GND 10.0
10.0 22 Digital Input
Led indicator I/Os state
B Zone
2s = -
R a S
Qc e 3]
s c £ c
o > >
o = T
<
GND GND GND
A0.7" 6 Analog Out
A0.6 5 Analog Out
A0.5" 4 Analog Out
Q/Vvdc - External Isolated Out Vdc
COM(l—) = External Isolated Out GND
Q0.7 6 Digital/PWM Out
Q0.6" 5 Digital/PWM Out
Q0.5" 4 Digital/PWM Out
Q0.4 40 Digital Out
Q0.3 39 Digital Out
Q0.2 38 Digital Out
Q0.1 37 Digital Out
Q0.0 36 Digital Out
Relay Shield

! See section 8 to select suitable switch configuration for enable these connections.

* Nok. use cormoctly confgurason for

use thve signal
(See user guise |

Rev 1: 02/03/2020

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*

(see section 8 to select the correct

configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs
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7.3  CZone (Relay Shield)

C Zone

05 £

c = a

=8 | 2 5
Qs =] ©

=09 B =

o < I

R1.8 42 Relay Out
R1.7 43 Relay Out
R1.6 44 Relay Out
R1.5 45 Relay Out
R1.4 29 Relay Out
A1.2 11 Analog Out
AL1" 10 Analog Out
A1.0" 8 Analog Out
GND GND GND
Q1.2" 11 Digital/PWM Out
Q1.1* 10 Digital/PWM Out
Q1.0 8 Digital/PWM Out

GNDCOM - External Isolated Out GND
24VCOM - External Isolated Out Vdc
Top Zone

= E0EE

Led indicator |/Os state

C Zone

=] £ c
EE R S

e e 5

=5 S 5

o = T
<

R0.3 30 Relay Out
R0.2 27 Relay Out
RO.1 28 Relay Out
GND GND GND

10.5 63 Analog/Digital Input
10.4 62 Analog/Digital Input
10.3 61 Analog/Digital Input
10.2 60 Analog/Digital Input
10.1* 19 Interrupt 1 In
()10.1 - GND 10.1
10.0" 18 Interrupt O In
(-)10.0 - GND 10.0

* Note: wsa corvedctly configurasan for

usa thi mgnnl

(se0 user guide)

Rev 1: 02/03/2020

Relay Outputs

Analog Output (Switch
Configuration)

Digital/PWM Outputs
(isolated)

Relay Outputs

Analog/Digital Inputs
Interrupt Inputs (isolated)
Configuration Switch*

(see section 8 to select correct
configuration for outputs).

See section 8 to select suitable switch configuration for enable these connections.
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7.4 D Zone (Analog Shield)
D Zone
o5 £
ur} a
o E2
R 2 S
QE e g -
S o ° c Analog
o < z 0-10Vde
Digtal
2.12 NC NC SN
12.11 NC NC gt
12.10 69 Analog/ Digital In 5- 24V
12.9 68 Analog/ Digital In
12.8 67 Analog/ Digital In
12.7 66 Analog/ Digital In
(-)12.6/INT1 - GND 12.6
12.6/INT1" 21 Interrupt 1 In
(-)12.5/INTO - GND I2.5
12.5/INTO" 20 Interrupt O In
()2.4 NC NC
12.4 NC NC
()12.3 - GND 12.3
12.3 35 Digital Input .
(22 - GND I2.2 e |
12.2 34 Digital Input 12 3——
(2.1 - GND I2.1
12.1 33 Digital Input Qe
O)12.0 s GND 12.0 o ,‘_‘E
2.0 32 Digital Input 21 ool
) 20—
g?'r.l‘ .-‘-_.]
Top Zone
S ———
- wce B o ~ 50« 55 - G-
Led indicator I/Os state
D Zone
2s £ c
R o o
2| & g
s = =
S| 2 z P~
< D
gt
GND | GND GND Hiia
A2.7 NC - o
A2.6" 13 Analog Out 2
A2.5 12 Analog Out — ‘GnD
Q/Vdc - External Isolated Out Vdc P e
COM(-) - External Isolated Out GND M L aos
Q2.7 NC s §
Q2.6" 13 Digital/PWM Out 5
Q2.5 12 Digital/PWM Out £
Q2.4 NC - 4
Q2.3 49 Digital Out .
Q2.2 48 Digital Out 558
Q2.1 47 Digital Out g
Q2. 53 Digital Out . g 8
b 4
| Z28d

Rev 1: 02/03/2020

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

See section 8 to select suitable switch configuration for enable these connections.
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8 Switch Configuration

8.1 A Zone: Communications

LEFT ZONE
Switch Analog Shield
ON | OFF
D ZONE
SCL/12.6 12.6 SCL
SDA/I2.5 12.5 SDA
C ZONE
RX1/11.1 11.1 RX1
TX1/11.0 11.0 X1
B ZONE
Pin 3/10.6 10.6 Pin 3
Pin 2/10.5 10.5 Pin 2
uSD & RS-485
D53(SD) Q2.0 SD
FD RS-485 HD HD FD
| OFF ON
SCL/NC
SDA /NC
Rx1/11.1
' Tx1/11.0
€ Pin3/10.6
Pin2 /10.5
D53(SD)
FD RS485 HD
| OFF ON

4. SCL/12.6: Choosing between SCL or the input 12.6. If this switch is ON, it enables the 12.6
input and disables the SCL. If this switch is OFF, it enables SCL and disables 12.6.

3. SDA/I12.5: Choosing between SDA or the input 12.5. If this switch is ON, it enables the 12.5
input and disables the SDA. If this switch is OFF, it enables SDA and disables 12.5.

2. RX1/I11.1: Choosing between RX1 or the input 11.1. If this switch is ON, it enables the 11.6
input and disables the RX1. If this switch is OFF, it enables RX1 and disables 11.1.

1. TX1/11.0: Choosing between TX1 or the input 11.0. If this switch is ON, it enables the 11.0
input and disables the TX1. If this switch is OFF, it enables TX1 and disables 11.0..
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4. Pin 3/10.6: Choosing between Pin 3 or the input 10.6. If this switch is ON, it enables the 10.6
input and disables the Pin 3. If this switch is OFF, it enables Pin 3 and disables 10.6.

3. Pin 2/10.5: ALWAYS AT OFF POSITION. Pin 2 and 10.5 Are used by the Sim800L module (The
GPRS/GSM Module). DON’T USE 10.5 and Pin 2!

2. D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables
Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD
can’t be used.

1. FD RS-485 HD: Choosing between FD or HF. If this switch is ON, it enables the Half Duplex
(HD) option and disables the FD. If this switch is OFF, it enables Full Duplex (FD) and
disables HD

LEFT ZONE [ ore
SWITCH ON OFF
NC - -
NC - - RYC m
RTC SCL RTC - RTYC tu
RTC SDA RTC -

1. RTCSDA: This switch enables the communication to communicate with the RTC using
I2C. Having this switch in ON mode it actives this communication, whereas if it is in
OFF mode it disables the 12C to reach the RTC.

2. RTCSCL: This switch enables the communication to communicate with the RTC using
I2C. Having this switch in ON mode it actives this communication, whereas if it is in

OFF mode it disables the 12C to reach the RTC.

3. NC: Not connected. This switch is not connected to anything, it doesn’t matter if it is in
ON mode or OFF mode.

4. NC: Not connected. This switch is not connected to anything, it doesn’t matter if itis in
ON mode or OFF mode.
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8.2  Analog and Relay Shields

Rev 1: 02/03/2020

B ZONE
SWITCH ON | OFF
NC - -
Q0.7 Q0.7 | A0.7
Q0.6 Q0.6 | A0.6
Q0.5 Q0.5 | A0.5

D ZONE
SWITCH ON | OFF
NC - -
Q2.7 Q2.7 | A2.7
Q2.6 Q2.6 | A2.6
Q2.5 Q2.5 | A2.5

CZONE
SWITCH ON OFF
NC - -

Q1.2 Q1.2 | Al1.2
Q1.1 Q1.1 | Al1a
Q1.0 Q1.0 | A1.0
18|NC

'éi Q1.2

&% Q1.1

£5la1o

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with Q0.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with A0.X, being X any number of the tables above.
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9 GPRS/GPS 1/0s 5V pins

The GPRS/GSM Controller has some of the Mega board pins available. These pins can be
programmed according to Arduino features such as 1/Os operating at 5V or any additional
features present in the pins (for example 12C communication in pins SCL and SDA). As this pins
are directly connected to the Arduino Mega board they are not as well protect as the normal
inputs. These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarized in the table below. In order to access some
of these pins the configuration switch must be set to OFF position (see section 8) and some
extra considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 12Cpins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case
it reads 5V when nothing is connected. The pull-up configuration is stablished by default in
these pins.

If itis meant to work them as a GPIO at 5V, it has to be considered that they are pull-up
inputs.

*IMPORTANT: 12.5 & 12.6 are not pull-up inputs although they are referred to the 12C pins
(switch configuration). There is a “reverse pull-up circuit “that is stablished in order to have the
same behaviour as the other inputs.

9.2  Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
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debugging, uploading and intercommunicating with the Ethernet controller. If using both
interfaces at the same time the Arduino board will get blocked.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.3  Serial 1 - RX1/TX1

In the GPRS/GSM Controller, Serial 1 is used to communicate through the Sim800L integrated
GPRS/GSM Module. If you want to use Serial 1 instead of GPRS/GSM, you must set the Pin 2
(Pin used as the GPRS/GSM) always at high position.

Remember: if you use the Seriall in your program, you will not be able to use the GPRS / GSM
functionalities!

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.4  SPI- MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.

9.5 Pin3

This pin is only referred to the inputs 10.1. If the switch configuration is in OFF position the pin
Pin 3 will be available.

These pins are not stablished with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be stablished an external pull-up or pull-down circuit in order to correctly work with
these pins.
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96 Pin2
REMEMBER THAT PIN2 IS USED BY THE SIM800OL MODULE AS RESET PIN, SO IS NOT

AVAILABLE IN THE GPRS/GSM CONTROLLER!

IF YOU WANT TO USE SERIAL1, YOU MUST SET THE PIN2 ALWAYS AT HIGH POSITION.
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10 A Zone Features: Communications & RTC & uSD

10.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

10.2 RS-485
For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects in this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD"” (See Section 8). This switch makes the choosing between RS-485
Half Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

10.3 12C

I2C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino Family. The pull-up
resistor is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the 12C communication.

Switch Analog Shield
ON | OFF

D ZONE
SCL/12.6 12.6 SCL
SDA/12.5 12.5 SDA
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To enable 12C the switches SCL/12.6(12.1) & SDA/12.5(12.0) must be set to OFF mode. In this
mode the inputs are totally disabled and the 12C is now enabled.

Industrial Shields does not provide any library to implement the 12C as it can be used the
standard library of Arduino called Wire.

10.4 SPI

The M-Duino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 SO 50
MOSI 5158l 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 8 to enable SS pins.

10.5 TTL

M-Duino has two TTL ports, RXO/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins O
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega).

In order to use the TTL pins the configuration of the switches have to be the following one:

Switch Relay Shield
ON | OFF
C ZONE
RX1/11.1 11.1 RX1
TX1/11.0 11.0 TX1

If the switches RX1/11.1 & TX1/11.0 are in OFF mode, the RX1/TX1 will be enabled. In order to
use TTL3 these switches must be in OFF mode.

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS
Arduino Mega pin 10).
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10.7 RTC

M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SW,\:TCH ON OFF RTC SCL & RTC SDA must be set to ON mode to enable
NE - - the 12C wires to the RTC. If they are in OFF mode, the

RTC SCL RTC : Arduino won’t communicate with the RTC.
RTC SDA RTC -

Switch Analog Shield

ON OFF I2C must be enabled in order to communicate with the

SCL/12.6 12.6 SCL RTC. See section 11 12C to enable it.
SDA/I2.5 12.5 SDA

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket. If this switch is
ON, it does not enable any pin, so you must putt he switch always at OFF position!

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

LEFT ZONE
Switch Analog Shield
ON | OFF
uSD
D53(SD) | Q2.0 | D53(SD)

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.
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Fy

L, Verify that the CPU is not actively running a process before inserting the memory card.

Inserting @ memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

4a» Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est
hors ligne et en sécurité.

10.9 GPRS/GSM

The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC and to
program it you must download this library on your Arduino IDE.

You can test the GPRS / GSM functionality using the examples that come with the library:

File EAL Sketch Tools Help

New Cut+N
Open. Cul+0
Open Recent

Sketchbook
Examples | 4
Close Cotaw Hobot Motor
Save Cules 50
Save As. CulvStufteS Servo
Spacebrowyun
Page Setup  Cul+Shift+p Stepper
Prant Culep Temboo
Preterences  Cul+Comma w101
RETIRED
Quit (ol e
10 e - Dupne Tam
EEPROM
Ethernet
RS-232
RS-485
RTC
SoftwareSerial
P
Wire
vt ples feoun Contom Libyase
Adatrot FONA Libravy | FONA3G setbaud
Adalnt GFX Libeary ] FONA_SMS_Response
Adalnut RASETS | FONAtest
DaltasTemperatire ' FONAtest KEY moxd
Etherne2 } GPS
HX711-master ' IncommngCall
One'Vare

When defining the pins in the program, take into account that the internal connections
between the Sim800l module and the Arduino Mega are the following:
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Arduino Mega Pinout
5Vdc
GND
Tx1 (Pin 18)
Rx1 (Pinl19)

Pin 2

How to define it in a sketch:

#tdefine FONA_RX 19 //RX1 on Arduino Mega

#tdefine FONA_TX 18 //TX1 on Arduino Mega

#tdefine FONA_RST 2

Rev 1: 02/03/2020

Sim800L Pinout
Vce
GND
TxD
RxD

RST

The GPRS/GSM protocol is always enabled as there are no switches that configure it.

the GPRS / GSM protocol uses the Seriall of the equipment to be able to communicate and the

pin2 for the module reset.

If you want to use Seriall, you must indicate in the program that pin2 is always in High
position. In case of using the Seriall, the GPRS / GSM communication can not be used.
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11 Instructions for interconnection between Industrial Shields
controllers

11.1 RS-232 Communication:

M-Duino 54ARA : iAnother Industn‘al' ‘

1/0s PLUS | ‘ Shields PLC
|KRFC-6 Forrie {4 Loops).
Tx Y S 2T S AT
RS22 puf _f.??.:'j.‘.,-;i‘}- Rx RE22
HIELOED CABLE
Farrite KITA Ferrite KITA
GND ~_~~ -~ H — GND
12728y : ~12:24v

11.2 RS-485 Communication:

11.2.1.1 Half Duplex

* M-Duino 54ARA Another Industrial
IOs PLUS | Shields PLC
KRFC4 Farrta (4 Loepa)
A N ™A
RS485 '~_'~_'\).a RS-485
(IE1 DED CARLE
Ferrite KITA Férrite KITA

GND ~_ I .~ GND
12124V m ‘ - - 12124V

I N J 1

11.2.2 Full Duplex

M-Duino Another Industrial

GPRS/GSM | Shields PLC
54ARA 1105
PLUS K_RFC-G Forrites (4 Leops)
ST " A
RS-485 PHB s e

Forrite KITA b= Faerite KITA
GND ~,— ) TR i -~ GND
12024y - - 12120V

39



Ref. 006001001100 Rev 1: 02/03/2020

11.3 Ethernet

KRFC4 Farnmte

1
|

M-Duino Another Industrial
GPRS/GSM Shields PLC
54ARA 1/0s
PLUS
Ferrite KITA Famie KITA

SECOHD pooocs,

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet
crossover cable must be used.
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12 1/0 technical details:

Digital Output Waveform:

[l o e——
y

DIGITALOUT

DIGITAL OUT

PWM OUTPOUT

leE

4

Pomem—ny

ARDUIND PAWM OUT

CHi= S.@al| |5 5,660 M 1.88ms | CHI % 268GEm.)
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Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT

ARDLINO OUT
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13 Typical Connections

GND \)
A/ sr2zev o o

SHIELDED CABLE

Ferrite KITA .

=8~

29N B ooraw

SHIELDED CABLE : L-meum

(-o:mu. NO-ISOLA
()00
—o o——| 0o
Ferrite KITA
£

gl \ POWER

sl B oomaw

SHIELDED CABLE / wumum

/
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DIGITAUANALOG INPUT
(Digital with external
SHIELDED CABLE
g 224V o 0.7
A GND ==
Ferrite KITA
gl ™® A POWER
= A224V J - DIGITAL/ANALOG IN
SHIELDED CABLE ]  feswewhaswssnmn
DIGITALANALOG N’m\/
(Analog)
010V
Y, W I
Ferrite KITA
@@“ 5 :
228V B  ooTamacew

SHIELDED CABLE / s et ey \_
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S

SHIELDED CABLE

SHIELDED CABLE

S

0-10v

A,

51224V —
GND

-

errite KITA

Ferrite KITA

12724V

SHIELDED CABLE /

==

0

10 POWER

Rev 1:02/03/2020

SHIELDED CABLE

GND !
-/ ALWAYS
CONNECTED
5%
O
VOUT = Q/Vde
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SHIELDED CABLE

Ferrite KITA

Rev 1:02/03/2020

\_‘ A
WAYS
TED
Ferrite KIT/ ®
GND VOUT = Q/ Ve
2124V
ks =
(< L
() ——
SHIELDED CABLE
G&IWI®
OUTPUT /
* Sew the switch
configutarion (ON)
5112724V
GND 3 A
ALWAYS
Jun CONNECTED
() SHIELDED CABLE
\\)I
POWER VOUT = Q/ Vde
E DIGITALIWM OUT

a4

SHIELDEDCABLE/ P o\
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K??\ [Soebo o

o8

by Q/Vee

-5 cOM () A
» ALWAYS

GND
|

SHIELDED CABLE/  wm

_ O Olea Jn
Ferrite KITA “~ L, -~ 05 @
POWER vour=a

E

\z iy
SHIELDED CABLE

RN, * See the switch
) configutarion (OFF)

GND =
A\ 01
(T o)

SHIELDED CABLE

Ferrite KITA o~
GND

= & POWER
224V E ANALOG OUT
SHIELDED CABLE Download the MOUINO LAYOUT:

47



Ref. 006001001100 Rev 1: 02/03/2020

14 Connector details:

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502
from Phoenix contact. MCO0,5/10-G-2,5THT

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference | MC 0,5/10-G-2,5 THT
Height 8,1Imm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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15 Mechanical Characteristics

- Dimension GPRS/GSM Controller:

- DIN Rail mounting

J_LF\A

Pufilctc ¢ ceppele W 3575

155,
785,
1 1M

%

Wtz

1

F2

é’ =
,_,]

Probien o coppelle T 35-15
wheallk®s Vg bt it M 2615

Sevene A/ Suce B i
Z sumed/Sdwd
CRANBITHHE MEWRO  LWEx  MEWD FEOUES TesE usts
Hean o SETHOO
Sumide  bawmiseekoewst  LABE & 0000 M o el kst 5 bl S o k. =T .
f T T ) O —— 7T — | W
U SN | NEL TEE— T (SR 7 ) S
ki ¢ b SAFS & b 7T — |l N )
ey IR I s vy -

Haleanic & caevn | At & adiom & metwide on ot mdzn | pegri gl

e dbbr & Fevea

Towesi vt P 1T
® — R ERE I LN X
13 Phoid bt Sndnek AR st
s [ I ———
q

Lx %
Bdusk o o wy denge o He etk wiert beg oliged B bewas
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16 Installation and Maintenance

Notes for installation:

- Theinstallation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the 1/0 of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particle,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino 42 |/Os PLUS from heat, high voltaje and eletrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino 42 1/0s PLUS. When configuring the layout of the M-Duino 42 1/Os PLUS inside
your panel, consider the heat-generating devices and locate the electronic-type devices in
the cooler areas of your cabinet. Reducing the exposure to a high-temperature
environment will extend the operating life of any electronic device. Consider also the
routing of the wiring for the devices in the electric cabinet. Avoid placing low-voltage
signal wires and communications cables in the same tray with AC power wiring and
highenergy, rapidly-switched DC wiring.

50



Ref. 006001001100 Rev 1: 02/03/2020

Provide adequate clearance for cooling and wiring M-Duino 42 I/Os PLUS. Is designed for
natural convection cooling. For proper cooling, you must provide a clearance of at least 25
mm above and below the devices. Also, allow at least 25 mm of depth between the front
of the modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and
disconnected from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a
way that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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17 Revision Table

Rev 1:02/03/2020

Revision Number Date Changes
0 29/08/2019 First implementation
1 02/03/2020 Second implementation
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com

Rev 1: 02/03/2020
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